
 

Release Notes 

MIMIC 
Version 5.1.1.0 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

© 2010 LIM, a wholly owned subsidiary of Morningstar, Inc. All rights reserved. 



  MIMIC 2 
 

  

Release 5.1.1.0 

Build Date 

Enhancements: 

 

 MC-110: Excel issue using MIMIC functions 

 MC-140: User can now disable pop-ups from MIMIC Excel Functions 

 

Bug Fixes:  

 MC-108: GetMIMDataPoint function – hourly data 

 MC-118: Updated the way MIMIC interacts with Excel’s toolbar when Uploader is installed first 

 MC-207: Displays values differently while, for example, changing to “Spanish(Spain)” in Regional and Language 

Options 

 MC-212: MIMICExcel: Numbers formatted incorrectly for Danish locale 

 

Release 5.1.0.9 

Build Date 

Enhancements: 

 

 MC-105: LIM error after installing verison 5.1.0.3 – fixed by disabling the ‘Check for updates’ 

 

Bug Fixes:  

 MC-95: applet tag in mimic.html/mimicng.html prevents MIMIC from launching in Excel.  Fixed by only using 

the <object> tag in the html files for MIMICExcel 

 

Release 5.1.0.8 

Build Date 

Enhancements: 

 

 MC-65: Add version in the connection message for MIMIC 

 MC-98: Description missing from the category relation TopRelation:AEP_Other 

 

Bug Fixes:  

 MC-30: No default<connection> in connections.xml lead to a run time error while refreshing a query. 

 MC-54 - MIMIC Excel and network home directory 

http://jira01.lim.com:8080/browse/MC-30
http://jira01.lim.com:8080/browse/MC-30
http://jira01.lim.com:8080/browse/MC-30
http://jira01.lim.com:8080/browse/MC-54
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 MC-66 - MIMIC Connection Manager: Raw Exception string displayed when MIMIC user not listed in 

xmimsvr.acl  

 MC-92 - MIMIC Adding extra invalid character at the end of factor when converting UoM.  

 MC-93 - MIMIC isn't working on windows 64 bit with office 2010 

 MC-95 - applet tag in mimic.html/mimicng.html prevents MIMIC from launching in Excel 

 

Release 5.1.0.7 

Build Date 

Enhancements: 

 

 MC-97: MIMIC Excel Applet should try the list of sockets if it  gets a SocketException 

 MC-91: Removed greyed out ‘Forward Curve’ tab 

 MC-88: Cloned Unit of Measure table for Platts Data 

 

Bug Fixes:  

 

 MC-94: MIMIC configuration lost when MIMIC user is not local (roaming profiles issue) 

 MC-87: Specifying spaces in the install directory causes MIMIC for Excel add-in to fail 

 

Release 5.1.0.6 
 

  Build Date 2009/03/24 

Bug Fixes: 

 

 SF13850: XmimGetDataPoint problem retrieivng data from the Real-Time store 

 

Release 5.1.0.5  
 

Build Date 2010/02/13: 

Enhancements: 

 

 [MC-X] MIMICExcel – Ensured default sorting order is consistent with spreadsheets created with older (e.g. 

3.1.0.7) versions of MIMCExcel. 

 
 

Release 5.1.0.3 
 

Build Date 2009/12/15: 

 Enhancements: 

http://jira01.lim.com:8080/browse/MC-66
http://jira01.lim.com:8080/browse/MC-92
http://jira01.lim.com:8080/browse/MC-93
http://jira01.lim.com:8080/browse/MC-95
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 Added support for roaming profiles. MIMICExcel Add-In and MIMIC standalone now search for the 

following environment variables to determine the user's home directory. 

               1.  LIM_USER_HOME 

             2.  HOMESHARE 

             3.  USERPROFILE 

 

Build Date 2009/10/30:  

Enhancements: 

 [MC-1] MIMICExcel - Added UDF (User Defined Function) GetMIMDescription 

 [MC-2] MIMICExcel - Added UDF GetMIMDataPoint.  

 [MC-3] MIMICExcel - Added UDF GetMIMConvPoint.  

 [MC-4] MIMICExcel - Added UDF GetMIMLastValue. [MC-5] MIMICExcel - Added UDF GetMIMLastDate. 

 [MC-6] MIMICExcel - Added UDF GetMIMExpDate. 

 [MC-7] MIMICExcel - Added UDF GetMIMExpValue. 

 [MC-9] MIMIC - Email Support. Added menu item Email LIM Support under Help to start an email addressed to 

LIM Support using the user's default email client. When the email is opened the user can click in the body of the 

email and press <Ctrl>+V to paste usefull information about the client. 

 [MC-16] MIMIC - Alert user when newer version is available. Upon startup the app will compare the current version 

with the latest version provided by the RSS feed and notify the user if a newer version is available. See 

http://customers.lim.com/download/rss_mimic_updates.xml 

 [MC-31] MIMICExcel - Added UDF GetMIMPath 

 

Bug Fixes: 

 #ESP-59521 MIMIC: An exception was being raised when charting a seasonal worksheet that had seasons going 

out into the future. Exception is now handled and the chart renders correctly. 

 #ESP-56676 MIMIC: Fixed number group separator for different locales. Numbers are now separated with comma, 

period or other character based on the user's locale. 

 

Release 5.0.0.0 
 
 

Build Date 2009/07/23: 

Requires Java 1.6 or higher 

Build numbers removed. Using dates as build numbers.  

http://customers.lim.com/download/rss_mimic_updates.xml
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Enhancements: 

 #ESP-57214 MIMIC: Added data preview to the browser. 

 

 #ESP-57213 MIMIC: Shortcuts have been re-designed to utilize a webservice. The service has been enhanced to 

implement public shortcuts allowing users to create and share their unique view of the MIM hierarchy. Requires 

LIM's shortcutsWs web services installed on Tomcat web application server. 

 

 #ESP-57215 MIMIC: Search web service. LIM's Search web services provides faster searches and flexible 

search parameters. Requires LIM's searchWs web services to be installed and search indices built. 

 

 #ESP-53271 MIMIC: Added drag and drop support from browser trees allowing users to drag items from the 

browser to the configuration table adding items to the worksheet. In MIMIC, only the valid items are allowed to 

be dragged. If any folders are selected the Drag feature is disabled. 

 

 #ESP-52991 MIMIC: When changing connection to a different server a modal dialog is displayed to notify the 

user that the connection is being established. 

 

 #ESP-53856 MIMIC: Display the date for a curve in the table. The date that a curve is based on is displayed in 

the description of the columns. 

 

 #ESP-54025 MIMIC: When descriptions change on the server they are not being updated in MIMIC. This is caused 

by MIMIC storing the information when it queries the server for the relation for the first time. Any subsequent 

requests use this cached information to reduce network calls to the server. Added "Clear Cache", "Refresh 

Worksheet" and "Refresh Automatically" menu items under the "File" menu item. If the user wants updated 

descriptions he must click "Clear Cache" and then "Refresh Worksheet". If "Refresh Automatically" is selected then 

any time the cache is cleared the worksheet is refreshed. 
 

Bug Fixes: 
 

 #ESP-55038 MIMIC: A bug was found that resulted in a 0 value for the y coordinate  if the min and max 

values in the series are equal. The actual value should be the top of the graphing area. Fixed. 
 

 #ESP-55043 MIMIC: When entering a symbol in the curve tab only the columns for the contracts are shown. 

Then if the user changes the type to a series the column combo-box is not updated with all the columns for the 

futures relation. Fixed. 
 

 #ESP-57716 MIMIC: Search status message not being updated when a search is performed resulting in more 

than 100 results and followed by a more narrowed search. Fixed. 
 

 #ESP-18686 MIMICExcel: Error when deleting an Excel sheet with MIMIC queries. If a cell is deleted and is 

referenced by an embedded query the target becomes invalid and causes error at runtime when refreshing all 
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queries. This has been addressed by gathering a list of invalid targets when refreshing and displaying the list after 

all queries have finished. User is prompted to enter MIMIC and either delete or edit and save the query to a valid 

location. This fix also addresses the issue when saving a query and the name exists but the target is invalid 

causing a runtime error when prompting the user to overwrite the existing query. 

 

Release 4.2.0.4 
 
 

Build 1.344.2.15 (2009/05/21): 

Bug Fixes: 

 #ESP-58119 MIMIC: Shortcuts not allowing user to use the popup menu to select non-leaf nodes in the tree. 

When the user selects a relation such as NG and right clicks the mouse to show popup menu and clicks on the 

"Select" menu item the event was not being passed through. Fixed. 
 

 #ESP-N/A MIMICExcel: Could not refresh queries when entering MIMIC then returning to Excel and trying to 

refresh queries. This was due to conflicting port usage by the MIMIC applet's socket reader and the Refresh 

applet's socket reader. Fixed by ensuring a unique port is used in both applets. 
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 #ESP-N/A MIMICExcel: Sun's Java 6u10 introduced bugs involving window focus when light weight windows 

were being drawn outside the boundaries of the parent window. Light weight windows such as tooltips would be 

shown but the parent window would occasionally be moved to the background behind the main window. This bug 

is described in Sun's bug database  bug id 6770457. We've added the workaround specified in Sun's bug database. 

This workaround allows MIMICExcel to run in all versions of Java 6. 

 

Release 4.2.0.3 
 
 

Build 1.344.2.14 (2009/04/27):  

Bug Fixes: 

 #ESP-57945 MIMIC: Shortcuts not expanding for dynamic folders. Fixed bug where the folders were not being 

populated correctly for the first level of children in a dynamic folder. 
 

 #ESP-58155 MIMIC: UOM Conversions not showing all possible values. Fixed bug where the Rel-Col 

conversions were not being obtained after the cache has been loaded. 

 

Release 4.2.0.2 
 
 

Build 1.344.2.11 (2009/03/25):  

Bug Fixes: 

 #ESP-56977 MIMICExcel: Queries not refreshing due to Applet not starting. Changed html file used for 

refreshing queries to use OBJECT tag instead of APPLET tag. Now both html files used for MIMIC excel use 

OBJECT tag. 
 

 #ESP-57238 MIMICExcel: Problem fixed for refreshing queries on Citrix. Port was not being set properly for 

socket communication between Excel and MIMIC. 
 
 
 
 
 

Release 4.2.0.1 
 
 

Build 1.344.2.9 (2009/03/17):  

Bug Fixes: 

http://bugs.sun.com/bugdatabase/view_bug.do?bug_id=6770457
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 #ESP-57005 MIMICExcel: Problems refreshing worksheet. Fixed bug that caused exception when Refreshing 

queires that contained items where the base units of measure were different than the units to convert to. 

 

Release 4.2.0.0 
 
 

Build 1.344.2.8 (2009/03/04): 

Enhancements: 

 #ESP-51221 - MimicExcel: User is now prompted for a query name on both Table & Chart commands. 
 

 Added menu item File->Clear Cache. Clears currently cached relations and units of measure. After units of 

measure are cleared they are re-loaded in a background process for improved performance when looking up units 

of measure for specified relations and columns. 
 

 Added menu item File->Refresh Worksheet. Synchronizes certain fields of the GUI with current meta data on the 

MIM server. 
 

 Added menu item File->Refresh Automatically. If checked the Refresh Worksheet action will be fired after the 

Clear Cache action has been performed. 
 

 Java 6u10 fix. Previous versions of MIMICExcel will not work with Java 6u10 or higher due to significant JRE 

changes by Sun as to how applets are ran. LIM developers have addressed these changes by modifying VBA and 

Java code. MIMICExcel Add-In will only run in Java 1.4 update 2 to Java 6u7. The preferred version of Java is 6u7. 

Users can have later versions of Java installed, such as 6u10, but must have 6u7 installed and enabled for Java 

Applets. 

                      Java 6u7 Download Site 
 

Bug Fixes: 
 

 #ESP-52514 MIMICExcel: Cannot change the query and re-embed over the previous without having to 

change names. Cannot keep old name. The following changes have been made. 
 

o Embedded queries may be opened, modified and re-embedded (i.e. saved) using the same name. 
 

o If an embedded query is opened and then modified it will be saved automatically if either the 

Table or Chart actions are selected. 
 

o User will be prompted to embed new queries when the Chart action is selected. 
 

 #ESP-53252 MIMICExcel: Show dates as columns. Bug fixed when "Show Dates As Columns" selected and 

running in Excel. 

http://java.sun.com/products/archive/j2se/6u7/index.html
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 #ESP-53263 MIMIC: Symbol descriptions do not show when "locate in tree" is used in the Search view. 
 

 #ESP-53565 MIMIC: Sorting by date column not working in the Table view when user clicks the column titles 

"Dates". 
 

 #ESP-54127 MIMICExcel: Keep formatting of Excel Cells in MIMIC Excel. Fixed bug where format was being 

cleared when data is tabled or refreshed. Now formatting remains as is. 
 

 #ESP-54218 MIMICExcel: Auto-refresh scripts do not refresh MIMICExcel queries when the PC is locked. 
 

 #ESP-54648 MIMIC: Units of measure not shown for continuous contracts. 

 

 #ESP-54649 MIMIC: Units of measure for Categories not being used. 
 

 #ESP-54932 MIMIC: User is getting "java.lang.NullPointerException" error when looking up Nymex data. 
 

 #ESP-55482 MIMIC: UoM not functional for HO_02. (Duplicate of ESP-54648.) 
 

 #ESP-55538 MIMIC: Server log showing incorrect MIMIC version when MIMIC connects to MIM server. 
 

 #ESP-55893 MIMIC: Tree View not populating description. MIMIC uses new API calls to populate the 

descriptions in the browser. The new API call is only availalbe on server versions 4.6.24 or later. A fix was 

added to MIMIC to handle older server versions. 
 

 #ESP-56612 Installer: MSI switch and Installation of MIMIC V4.1. The option to install or not install the MIMICExcel 

addin was not functioning. This has been fixed in this version's intaller. 

 

Release 4.1.0.4 
 
 

Build 1.329.2.20 2008/08/29: 

Enhancements: 

 #ESP-50979 - MIMIC warning message stating "Formulas may be incorrect" when deleting items. Added 

check box to allow user to choose not to display the message during the current MIMIC session. 
 

 #ESP-52358 - MIMIC error message when invalid host name is entered. Added more information to state that 

the host is invalid. In previous versions the message from the server or network layer was just displaying the 

hostname. Now MIMIC checks if the exception type is HostNotFoundException and lets the user know 

accordingly. 
 

 #ESP-N/A - Improved Shortcuts on the server side. LIM now has a shortcuts web service that MIMIC can 
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utilize. This allows for larger shortcut trees without loading the entire shortcut tree into RAM on the client side. 

MIMIC requests sections of the shortcuts trees that the user expands. 
 

 #ESP-N/A - Improved performance when browsing. Performance has been improved significantly, especially when 

connected to remote servers where latency is high. Previously MIMIC was unusable when latencies exceeded 

100ms. Browsing has been improved so that latencies on average of 200ms are not significantly noticeable. More 

work is scheduled to improve other areas of MIMIC such as fetching information for relations and columns when 

user enters a relation name. 
 

 #ESP-N/A - Curves have been enhanced to be smoother and not stepped. An option has been added to the User 

Preferences to allow the user to choose a stepped curve. By default curves are not stepped. 
 

Bug Fixes: 
 

 #ESP-50577 MIMIC: Graph printing cuts off the titles and legends. Fixed. 
 

 #ESP-51830 MIMIC: "Save as Defaults" in Chart config not saving as default. Fixed. When user modifies any 

color, line thickness or symbol settings for the chart the changes are made to the current session of MIMIC and 

any new worksheets. If the user chooses "Save As Defaults" then the settings are written out to a file and used 

for future MIMIC sessions. Choosing "Load Defaults" will restore the settings to the original values MIMIC is 

shipped with. 

 

Release 4.1.0.3 
 
 

Build 1.329.2.19 2008/07/31: 

Bug Fixes: 

 #ESP-N/A MIMIC: Fixed bug where the user defined preferred column set in the property file was not 

being displayed by the browser or the search tree views. 
 
 
 
 

Release 4.1.0.2 
 
 

Build 1.329.2.17 2008/07/30: 

Enhancements: 

 #ESP-N/A MIMIC: Added property for user to specify in the user property file that skips the daily data check 

when MIMIC is trying to identify the preferred column. Default value (i.e. property not found) is true. 
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        lim.mimic.pref.cols.daily.check=false 

 

 #ESP-N/A MIMIC: Added property available by the User Preferences dialog to allow the user to set the 

default value for "Skip All NaNs". Previous versions of MIMIC always created new worksheets with the "Skp 

All NaNs" check box checked. User can now change the default setting by going to Options->User 

Preferences menu item and set the "Default to Skip All Nan" checkbox accordingly. 
 

 #ESP-51764 MIMIC: Added user preference to allow user to set the default print mode to color or black and 

white. 
 

Bug Fixes: 
 

 #ESP-N/A MIMIC: Fixed bug when receiving browser event to add item with column Mid*. An error was being 

shown stating that the relcol does not exist. Changed to check that Low and High exist when the column being 

added is Mid*. 

 

Release 4.1.0.1 
 
 

Build 1.329.2.13 2008/07/22:  

  Bug Fixes: 

 #ESP-N/A MIMIC: Bug fixed where "Save" and "Save As" actions were not working for chart or tables. 

 

Build 1.329.2.12 2008/07/18:  

Enhancements: 

 Better use of cached data from the server to significantly reduce the number of API calls to the server and 

improving the user's experience. 
 

 #ESP-21290 MIMIC: Added "Alias Target" column to the item table. This column will display the target if the 

item is an alias. To enable this feature the user_prop.txt file must have the following property added. 
 

        lim.mimic.alias.target.factory=class_name 
 

Where 
 

        class_name 
 

is the name of a class that implements 

 
         com.lim.alias.AliasTargetGetter 

 

Bug Fixes: 
 

 #ESP-51812 MIMIC: Fixed bug where an error dialog was being displayed after saving an llc file. The file was still 
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being saved and was only an annoyance since the error had nothing to do with the current operation. 
 

 #ESP-51784 MIMIC: Fixed bug that showed duplicate set of columns in browser. 
 

 #ESP-51744 MIMIC: Fixed bug when selecting items in the browser or search views by right-clicking on the 

relation and choosing "Select". An error stating "ERROR: relcol does not exist [relname null]" was being 

displayed. 
 

 #ESP-N/A MIMICExcel: Fixed bug when trying to open embedded queries created with versions of MIMIC prior to 

v4.0. An error stating "ERROR:null" was being displayed. 

 

Release 4.1.0.0 
 
 

Build 1.329.2.3 2008/06/19: 

Enhancements: 

 #ESP-41742 MIMIC: Fixed inconsistency between Edit menu item and right-mouse-click pop-up menu on the 

item table in Config and Browser modes. 
 

 #ESP-45021 MIMIC: Curve matrix. Precision of output changed to match the select precision. 
 

 #ESP-47044 MIMIC: Changed the functionality of the "start date" "end date" logic. If start date is relative and 

user changes end date then start date adjusts as defined by "Change Period". 
 

Bug Fixes: 
 

 #AT-19 MIMIC: Fixed bug where the date format was not being represented in the Seasonal Analysis dialog and 

the Curve date panel. 
 

 #AT-1691 MIMIC: Fixed bug where browser refresh was not working when the server has been restarted. 
 

 #AT-1692 MIMIC: Fixed bug where browser refresh was not expanding previously expanded paths or last 

selected path. 
 

 #ESP-50577 MIMIC: Fixed bug when printing charts. Long titles were being truncated. Now title wraps if 

necessary. 
 

 #ESP-50676 MIMIC: Fixed bug with Stored Formulas causing formulas to not get stored on server properly. 
 

 #ESP-50738 MIMIC: Fixed bug where query was not be created correctly for Seconds time period. 
 

 #ESP-50961 MIMIC: Fixed bug where sheets created with older version of MIMIC was throwing a 
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NullPointerException. 
 

 #ESP-51044 MIMIC: Fixed bug when using online catalog and adding rel/col that does not exist on users local 

MIM server. 
 

 #ESP-51092 and ESP-51123.1 MIMICExcel: Fixed bug where user embeds a query, then creates a new query and 

tries embedding it. The new query was overwriting the old query due to the VBA code thinking the user was still 

working on the previous query. 
 

 #ESP-51123.2 MIMIC: Fixed bug with trendlines slow to display or not showing at all. 
 

 #ESP-51123.4 MIMIC: Fixed bug when running seasonal analysis weekly queries. 
 

 #ESP-51291 MIMIC: Fixed bug where application was unable to chart CONSUMPTION.GAS.ALL.GRTGAZ. 

 

Release 4.0.1.2 
 
 

Build 1.306.2.21 2008/05/13: 
 

Bug Fixes: 

 MIMIC: Fixed a bug in the Alias tool which is part of MIMIC's library. 
 
 
 

Release 4.0.1.1 
 
 

Build 1.306.2.20 2008/04/25: 

Enhancements: 

 #AT1382 (Enhancement) MIMIC: About box modified to allow user to select all the text to facilitate sending 

information to client support. 
 

 #AT1616 (Enhancement) MIMIC: License checking removed until a better solution can be provided for 

companies with large user base. 
 
 
 

Bug Fixes: 
 

 #AT1606 (Bug Fix) MIMIC: Fixed location of notes dialog to always display on screen when adding notes to a 

chart. 
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Release Candidate 4.0.0.2 
 

Build 1.306.2.11 2008/03/06:  

Bug Fixes: 

 #AT1193 MIMIC: Change thickness of lines doesn't seem to work. 
 
 
 
 

Release Candidate 4.0.0.1 
 

Build 1.306.2.10 2008/02/26:  

Bug Fixes: 

 #AT1086 (Bug Fix) MIMIC: The chart legend is cutting off no matter how the window is resized. 
 

 #AT1087 (Bug Fix) MIMIC: The browser "select" popup window is not working on first attempt. 
 

 #AT1088 (Bug Fix) MIMIC: The browser multi-select is not working. 
 

 #AT1089 (Bug Fix) MIMIC: When clicking “New Worksheet”, application is not releasing the old file and not 

prompting when saving thus causing the previously saved file to be overwritten. 
 

 #AT1090 (Bug Fix) MIMIC: InvalidClass Exception: Users were unable to share worksheets due to a 

serialization problem. 
 

 #AT1091 (Bug Fix) MIMIC: After charting query and changing colors in the Chart Configuration, turning on the 

View>Chart>Options>Controls, and clicking the Mouse Pick Off Button, the colors are not updating. 
 

 #AT1092 (Bug Fix) MIMIC: When printing a chart in color, and selecting Options>Color Print and then changing 

the Color Print settings in the Color Print tab of the Chart Configuration window, the chart printed in the color 

that was defined on the Chart Configuration tab, not on the Color Print tab. 
 

 #AT1093 (Bug Fix) MIMIC: Intraday date format in table does not show a two digit minute. When tabling 

intraday data the format for the datetime is H:M:S. There was no zero padding. Format should be 

HH:MM:SS. 
 
 

Release Candidate 4.0.0.0 
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Build 1.306.2.8 2008/02/22: 

Enhancements: 

 Incident 15874, #AT7 MIMIC: User has control of Y-axis in a chart. 
 

 Incident 38581, #AT14 MIMIC: You can now right click in the "Chart Type" column and make all the items the 

same chart type. 
 

 Incident 44831, #AT15 MIMIC: When there are more than 100 results then the results may be limited by the 

server. There is now a message on the Report: "Found 100 Results. (Results may be limited to 100 by the 

server.)" 
 

 Incident 45815, #AT20 MIMIC: Enabled user to refresh the browser tree. 
 

 #AT52 MIMIC: The new installer for MIMIC does not require configuration. The host and port are located by the 

application and will prompt the user if not found. The installer just needs to know where to install the application 

and if the MIMICExcel Add-in should be installed (default is to install the Add-in). The host and port numbers are 

managed in the new Connection Manager, where these server connections can be added and edited. 

 Incident 17882, #AT60 MIMIC: The user can now add text notes onto a MIMIC graph. Incident 23390, #AT65 

MIMIC: Allows the user to define the line thickness for each series 
 of data on the chart. Similar to Color Configuration. 

 

 Incident 32935, #AT66 MIMIC: The user can now specify the symbols to use for each data series in a chart. 

Similar to Color Configuration. 
 

 Incident 35648, #AT67 MIMIC: Allows the user to select multiple items in the tree view and drag them to the 

"Add to Favorites" button. The Favorites dialog is updated to be more like a file chooser dialog with a filter for .itm 

files. 
 

 Incident 44719, #AT68 MIMIC: Allow the user to use the arrow keys and the Enter key to control the mouse 

pick lines. Left, right, up and down arrows move one pixel at a time. The Enter key will lock in the current 

selection, similar to a mouse click. 
 

 Incident 25321, #AT69 MIMIC: Results in portrait/landscape format. Currently results are formatted in the table 

where columns="values for a relation" and rows ="dates for the values". The User can now change it to: 

columns="dates for values" and rows="values for a relation" 
 
 

Bug Fixes: 
 

 Incident 20786, 22332, #AT8 MIMIC: Added quarterly execution units to Seasonal Analysis. 
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 Incident #AT7 MIMIC: Updated the date controls in the Curve Item pane and the Seasonal Analysis dialog window 

so that they conform to match the User Preferences window. 
 

 Incident 44833, #AT49 MIMIC: What a relation is entered the "Time Units" should be set to the default units for 

that relation. 
 

 Incident 41117, #AT61 MIMIC: The user is prompted for a different host and port when the specified server 

does not respond. 
 

 Incident 38432, #AT63 MIMIC: The user is allowed to cancel a search. 
 

 Incident 40366 MIMIC: When using the curve tab, the chart label did not change to match the chart date. 

Now, touching the date controls sets the label to the appropriate date (or "Last Data Day"). 
 

 Incident 46189 MIMIC: MIMIC did not remove the tag descriptions for FTI data in the Label/ Configuration area. 

Descriptions will now display properly. 
 

 Incident 42586 MIMIC: If a user created a MIMIC curve from the Curve tab without entering a valid symbol a 

blank error message displayed. Now, a meaningful error message displays. 

 

Release 3.2.0.4 
 

Build 1.228.4.36 2007/11/29: 
 

Bug Fixes: 

 Time Units : When choosing "Secondly" for the time units of individual items the query was being created 

incorrectly. Changed from "Secondly" to "Seconds". 
 

 Incident 45860 (Defect ID #1426): Formula Description Table Summary appears twice. Table statistics were not 

being calculated for Bar columns. 
 
 
 
 

Release 3.2.0.3 
 

Build 1.228.4.35 2007/10/04: 
 

Bug Fixes: 

 Incident 43498 MIMICExcel: When closing MIMIC, if you use the X to close the form then Excel hangs when re-

entering MIMIC. Fixed by changing the behavior of the red X to hide the form instead of terminating MIMIC. 
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Release 3.2.0.2 
 

Build 1.228.4.33 2007/09/21: 
 

Bug Fixes: 

 Incident 39751 MIMIC: Bug in the MIMICExcel query description dialog. Fixed by increasing the height of the 

controls. 

 Incident 44083 MIMICExcel: When a mistake is made in MIMICExcel, the error prompt causes MIMICExcel to 

hang. Fixed by removing callback from VBA. 
 

 Incident 43498 MIMICExcel: Hanging on errors and relocating embedded queries. Relocating queries has 

been fixed. Error dialogs fixed. 
 

 Incident 44275 MIMICExcel: Receiving errors when launching Excel after uninstalling MIMIC. Fixed by moving 

the uninstall action up in the UI sequence. 
 

 Incident 43426 MIMICExcel: When using the new MIMICExcel, clicking on Open says Loading... and then freezes. 

Fixed by removing the callback from VBA. 
 
 
 
 
 

Release 3.2.0.1 
 
 

Build 1.228.4.26 2007/08/10: 
 

Enhancements:: 

 Issue 43495 MIMIC: Add LmpVal to the list of preferred columns. This allows LmpVal to be the default column if 

no other preferred column is found. Fixed by adding LmpVal to the list of preferred columns. 
 

Bug Fixes: 

 Issue 43439 MIMICExcel: Errors when removing mimic excel add-in. Added error trapping in the install.xls 

macros. 
 

 Issue 43426 MIMICExcel: When using the new MIMICExcel, clicking on Open says Loading...and then freezes. 

Fixed by reworking threads. 
 

 Issue 43557 MIMICExcel Add-In: Program freezes when trying to table a query and “No Data” error. Fixed by placing 

error dialog on AWT thread. 
 

 Issue 43690 MIMIC: Favorites does not insert when in insert mode. Only appends. Fixed to insert if in “insert” 
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mode. 
 

 Issue 43615 MIMICExcel: Queries not sorting by date as specified in worksheet when refreshing MIMIC Queries. 

Fixed. 
 
 
 
 
 

Release 3.2.0.0 
 
 

Build 1.228.4.22 2007/08/01: 
 

Bug Fixes: 

 Issue #43415 MIMICExcel: Fixed bug to give status bar control back to application. 
 

Build 1.228.4.22 2007/08/01: 
 

Bug Fixes: 

 Issue #43433 MIMIC: Fixed Curve Matrix Tool to not format numbers with a comma. 
 

Build 1.228.4.21: 
 

Bug Fixes: 

 Issue #43186 MIMIC: Color configuration not being saved when changes are made. 
 

Build 1.228.4.19: 
 

Bug Fixes: 

 Issue #43036 MIMIC: Curve matrix giving error when expiration date not set on relation. Fixed to be more 

aggressive in trying to get the expiration day. 
 

Build 1.228.4.17: 
 

Bug Fixes: 

 Issues #41266, 42698 MIMIC: User preference window fails to launch. 
 

Build 1.228.4.16: 
 

Enhancements: 

 Issue #31411 MIMIC: Save worksheet contents and properties to file. 
 

 Issue #35796 MIMIC: Enabled user to execute Chart/Table from the browser/search window. 
 

 Issue #36591 MIMIC: When a query causes an error due to an item in the sheet, MIMIC attempts to find the row 
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in the table and highlights it. 
 

 Issue #37038 MIMIC: Added “Avg Day Monthly” to line items for building queries that show the “monthly 

average of an hourly price”. 
 

 Issue #38083 MIMIC: Search defaults to descriptions or symbols based on users last selection. 
 

 Issue #38114 MIMIC: Mouse copy, paste, delete and insert items from item table. 

 

 Issue #38219 MIMIC: Allow user to add to Favorites from Browser panel. 

 Issue #38230 MIMIC: Added default value for “Show table stats”. 
 

 Issue #38249 MIMIC: Added Worksheet property to include/exclude weekend values. 
 

 Issue #39127 MIMICExcel: MIMICExcel Save/Open menu items are now more consistent with stand-alone 

version. 

 

Bug Fixes: 

 Issue #39272 MIMIC: Queries with curve items now try and get the expiration date from the MIM.  

 Issue #34116 MIMIC: Fixed bug that kept embedded queries from refreshing and having to be tabled manually. 
 

 Issue #36330 MIMIC: Seasonal chart label bug fixed for items that are invisible. 
 

 Issue #36561 MIMICExcel: MIMICExcel locks up when user opens saved query numerous times.  

 Issue #37812 MIMIC: Name of the days now appear on the calendar in MIMIC Curve tab. 

 Issue #38500 MIMIC: Legends in Seasonal Charts with a baseline are showing correctly. 

 #AT1094 MIMIC: Default values for "Show Summary Stats" and "Sort Date Ascending" should be set to what 

the user has in property file. The default value is "true" if the property does not exist. 

 

Release 3.1.0.7 
 
 

Enhancements: 

 Issue #31411 MIMIC: Save worksheet contents and properties to file.  

 Issue #32794 MIMIC: Multi-select capability for search results. 
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 Bug Fixes: 

 Issue #33678 MIMIC: "All Data" Change needs tailoring. When "All Data" is selected: If "Relative" is on then WHEN 

condition is empty. If "Relative" is off WHEN condition is from start date to last data date. 
 

 Issue #31544 MIMIC: Seasonal Table Not working for weekly.  

 Issue #32204 MIMIC: Button images causing problem in add-in. 

 Issue #32976 MIMIC: Search control fetching descriptions locks MIMIC.  

 Issue #33206 MIMIC: Number of Units not being saved. 

Release 3.1.0.6 
 
 

Enhancements: 

 Issue #32649  MIMIC: ”llc - Hotlist Browser”. To be consistent we need to call it “MIMIC – Favorites Browser”. 
 

 Issue #32365 MIMIC: Change behavior of date option "All Data". In order to insure all data for a query is 

returned, changed “All Data” to call executeQuery  with invalid dates and the WHEN clause is empty. 
 

 Issue #32663 MIMICExcel: Would like Digital Cert for Install Code signed VBA Projects for install.xls and 

mimicexcel.xla with certificate issued by Thawte. 

 

Bug Fixes: 

 Issue #32625 MIMIC: Custom rollover loses the "to last" property when changing number of days.  

 MIMIC: Fixed bug when modifying rollover policy to retain the “to last” property when number of days is changed. 
 

 Issue #32204 MIMICExcel: Button images causing problem in MIMICExcel add-in for Excel version 9.x 
 

 Issue #32203 MIMICExcel: If chart or other object is selected and user enters MIMIC or refreshes MIMIC queries 

they receive “error:Object variable or With block variable not defined”. Resolved by getting address of active cell. 

If no cell is active then default to $A$1 of the active sheet. 
 

 Issue #32094 MIMIC: Bug with prompting of incorrect formula. When removing items from a MIMIC worksheet 

with formulas, the app was prompting only if the user removed a formula. Corrected this by having the app 

prompt user when any item is being removed from a worksheet containing formulas. This is due to the fact that 

labels are changing and users formulas may be referencing the labels. 
 

 Issue #31512 MIMIC: If skip NaNs checked, Fill NaNs should be greyed out. 

 Issue #31249 MIMICExcel: Renaming query not working correctly, causes 2 queries to be saved. The dialog for 
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opening, editing, renaming or deleting saved queries has been redsigned making it more intuitive and user friendly at 

the same time fixing the bug when renaming the query and resulting in 2 queries. 
 
 
 
 

Release 3.1.0.4 
 
 

Enhancements: 

 Issue #30629 MIMIC: Added “Fill Blank” option for Missing Data. 
 

 Issue #30631 MIMIC: Added feature to synchronize all Time Units or Columns with currently selected 

item. 
 

 MIMICExcel: Changed dialog for opening, deleting, renaming and copying saved queries. Made the dialog more 

intuitive when renaming a query. 
 

Bug Fixes: 

 MIMIC: Fixed bug when opening saved MIMIC files (.llc) by double clicking on the file in Windows Explorer. 
 

 Issue #21925 MIMICExcel: Fixed bug when renaming a query and thecomment on 

the cell was not being updated. 

 

Release 3.1.0.2 
 
 

Enhancements: 

 Issue #29451 MIMIC: Added option when importing symbols to remove blank rows 
 

 MIMIC: Modified Browser to be more responsive/informative.  

 MIMIC: Added "mid*" to the columns in the "Search" panel. 

Bug Fixes: 

 Issue #29450 MIMIC: Bug fix in "Search" panel when connected to server versions 4.5.06 and older. 
 MIMIC: Fixed bug in "Search" panel when selecting columns.  

 

 

Release 3.1.0.1 
 
 

Enhancements: 

 Issue #29451 MIMIC: Added option when importing symbols to remove blank rows 
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 MIMIC: Modified Browser to be more responsive/informative.  

 MIMIC: Added "mid*" to the columns in the "Search" panel. 

 Issue #26518 MIMIC: Added enhancement to import symbols from a .llc, .csv or .txt file. Csv and txt files should 

be in the format: SYMBOL[,COLUMN] where column is optional. If the column is omitted then the default column 

for the symbol will be used. 
 

 Issue #22813 MIMIC: Added control for user to select orientation of the chart legend. Possible orientations are 

horizontal and vertical. The user may also elect to have the legend anchored in the North (default), West, South 

or East positions against the chart. 

 Issue #22332 MIMIC: New seasonal analysis functionality giving user more control over averages when running 

a seasonal analysis. 

 Issue #29451 MIMIC: Added option when importing symbols to remove blank rows 
 

 MIMIC: Modified Browser to be more responsive/informative.  

 MIMIC: Added "mid*" to the columns in the "Search" panel. 

 

Bug Fixes: 

 Issue #26428 MIMIC: Problem when opening MIMIC 3.02.2 - pop up screen: Launching  

 MIMIC 3.0.2.1. Typo in the version string for the .exe. Fixed to reflect correct version. 
 

 Issue #27040 MIMIC: Hotlist unable to remove directories. Fixed hotlist dialog to remove directories 

when user selects “Delete”. 
 

 Issue #25742 MimicExcel: Some installations were getting a runtime error “The object invoked has disconnected 

from its clients”. This was due to libraries being loaded/unloaded in VB. When Mimic is ran from Excel the Java 

code in Mimic will load the DLLs necessary for Mimic to run. 
 

 Issue #25612 MimicExcel: Run time error '9': Subscript out of range; Application-defined or object-defined 

error. Bug when reference is lost and user tries to table or save the query. Fixed by capturing the error and 

prompting user to reset the reference. 
 

 Issue #25565 MimicExcel: Getting runtime error 6 when running excel add-in. Caused by jvm.dll already being 

loaded when the mimicexcel.dll tries to load and attach to the jvm. Fixed by not loading jvm.dll specifically and 

allowing the Java plugin to load it. 
 

 Issue #25494 MimicExcel: Spreadsheets with several long running queries seems to hang when refreshing. 

Fixed by having the VB code “pole” the library call that fetches the data returned by Mimic. Upon completion 

of executing a Mimic query, the poling will end and data will be transferred to the Excel spreadsheet. 
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 Issue #21925 MimicExcel: Renaming a query does not update the name on the comment of a cell within the 

Excel spreadsheet. 

 

Release 3.0.2.2 
 
 

Enhancements: 

 Issue #21042 MIMIC: Add Contracts feature hangs when hitting OK without entering in fields. There was no 

bug. If the user clicks OK in the "Add Contracts" dialog without filling in the options, then every contract will be 

added. This can be a potentially long operation. The new release will display a progress dialog showing the user 

exactly what is being added. 
 

 Issue #23436 MIMIC: Display date in mm/dd/yyyy format when using Mouse pick. The year was not being 

displayed in the chart's Mouse pick table. This has been corrected. 
 

 Issue #22712 MIMIC: Need user option to show ".internal" folders. For internal use only. Internal folders are 

filtered out of the browser tree by default. If the user wishes to view these folders they must add the property 

"lim.browse.internal=true" to their userprop.txt file. 

 

 Issue #22063 (Enhancement) MIMIC: Deselected "Show in Table" feature is not passed on to contracts when 

using "Add Contracts" button. Newly added contracts will have the same properties as the base symbol. 

 
 

Bug Fixes: 

 Issue #21770 MIMIC: Doesn't let you resize results window. Older version let you. Some users like to compare 

tables by making the window small enough to only show the table and then place that window next to another 

window with a table allowing them to eyeball each row. MIMIC will allow users to resize the window to their 

desired dimensions. 
 

 Issue #22603 MIMIC: Bug handling of unit conversions when frequency changes. 

 

 Issue #22617 MIMICExcel: Bug output from seasonal analysis changes when refreshing from the Excel view. When 

"refreshing" queries from MIMICExcel, the saved query's dates were not being reflected by the MIMIC Worksheet 

model. Specifically if the saved query had "Relative" or "Today" specified for the start and end dates. This has been 

fixed. 
 

 Issue #22718 MIMIC: Bug when sorting results, time does not sort correctly. Tables are now sorted by Date and 

Time. 
 

 Issue #23365 MIMIC: Getting error when running 3 year calendar strip on HO. There was a bug when charting a 

worksheet that had no data being displayed. Although data was returned by the query, there was only one item 



  MIMIC 24 
 

  

set to be shown in the chart. This item had no data and an error occurs when trying to build the axis. This has 

been fixed by displaying a message "No Data To Chart" back to the user. 
 

 Issue #21925 MIMICExcel: Renaming a query doesn't update the name on the comment within Excel. In this 

release the comment tag is now being updated with the new name.  

 

Release 3.0.2.0 
 
 

Enhancements: 

 Issue #18984 MIMIC: Add ForwardFill to “end date” 
 

 Issue #18433 MIMICExcel: Added “Advanced Refresh Mode” allowing users to modify the date range when 

refreshing queries. 
 

 Issue #20604 MIMIC: AddContracts allows user to select columns with no data. Customer requests to be 

warned or blocked. 
 

 MIMIC: Check symbol text field for changes when chart/table action occurs. If changed, then update table 

with symbol. 
 

 MIMIC: Foundation for Forward Curves added. Only available for demos.  

  Bug Fixes: 

 Issue #19360 MIMIC: Bug in hotlist when non-hotlist files exist. 

 Issue #20116 MIMIC: “Edit Chart Stats” not visible until the window is resized.  

 Issue #20445 MIMIC: Curve Matrix ignores column selected and defaults to Close.  

 Issue #20784 MIMIC: Symbol not being trimmed resulting in error. 

 
Release 3.0.1.6 

 
 

Enhancements: 

 Issue #18235  MIMIC: Display Java run-time version in Help>About. 
 
 
 
 

 Issue #18985 MIMIC: Add shortcuts. 
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 MIMIC: MIMIC remembers the status of the browser when exiting. 
 

Bug Fixes: 

 Issue #17479 MIMIC: not displaying answers correctly for seasonal analysis queries.  

 Issue #17797 MIMIC: Possible bug with MIMICExcel using copy function. 

 Issue #18128 MIMIC: Bug with charting seasonal analysis. 
 

 Issue #18683 MIMICExcel: Runtime Error: Object doesnt support this action.  

 Issue #18686 MIMICExcel: Error when deleting Excel Sheet with MIMIC queries.  

 Issue #17266 MIMICExcel: Doesn't handle bad location reference elegantly. 

 

Release 3.0.1.5 
 
 

Enhancements: 

 Issue #16785 MIMICExcel: Add location to Sheets dialog (when opening saved queries).  

Bug Fixes: 

 Issue #16210 MIMIC: Graphs will not print in color. 

 Issue #16214 MIMIC: Printing a chart comes out as a "red" block. 
 

 Issue #16423 MIMIC: Looks like the modifier "front" is missing from MIMIC. 
 

 Issue #16701 MIMIC: Custom contract becomes grayed out when moving the highlighting from a non-future to 

a future. 
 

 Issue #16521 MIMICExcel: sheet load blows up. 
 

 Issue #16863 MIMICExcel: Dates are not formatted/aligned properly for European settings.  

 Issue #16187 MIMICExcel: Status Bar disappears. 
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 Issue #16334 MIMICExcel: When opening a MIMIC query, get a Base64FormatException. 

 

Release 3.0.1.3 
 
 

Enhancements: 

 MIMIC: Screening criteria categorized. Screener rc2 required. 

 Issue #15724 MIMICExcel: Label a query created by the conversion tool with its location.  

 Issue #15780 MIMICExcel: Add a Menu for MIMICExcel & if new version of Excel, add buttons in toolbar. 

 

Bug Fixes: 

 Issue #15562 MIMIC: Bug with crashing with four monitors. 
 

 Issue #15677 MIMICExcel: Update Problem when MIM query returns zero results. 
 

 Issue #15681MIMICExcel: When a query is opened, the Locator does not update with the new address. 
 

 Issue #15736 MIMIC: Columns do not exist in tree for ICE.CINERGY. 
 

 Issue #15983 MIMICExcel: VBA error when no workbook open and user launches MIMIC. 
 

 
 
 
 

Release 3.0.1.1 
 
 

Enhancements: 

 MIMIC: Added Screener panel. 
 

 MIMICExcel: Added Conversion Wizard to convert MIM-Excel queries to MIMIC llc worksheets. 
 

 Issue #15724 MIMICExcel: Label queries created by converter with its location 
 

Bug Fixes: 

 Issue #15550 MIMIC: Default column for futures contracts was selecting "Continuous" if no “default” column 

found. 
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 Issue #15681 MIMICExcel: Update ref_edit control with new address when "Edit" query is selected. 
 

 Issue #15677 MIMICExcel: conversion hangs when no data found. 
 

 Issue #15172 MIMIC: Bug when no trade segments for category/relation 
 

 Issue #14988 MIMIC: Bug when restoring default chart colors 

 

 

Release 3.0 
 
 

Enhancements: 

 Issue #11243 MIMIC: Added "Print Options" panel to "User Options". Allows user to set print orientation. 
 

 Issue #12668 MIMIC: Added 1 Day ago, 2 Days ago, and 1 Week ago to MIMIC's period combo box. 

(02/12/2004). 
 

 Issue #12926 MIMIC: Added a check box to MIMIC's Login Screen to allow the user to save login info. 

(02/02/2004). 
 

 Issue #12670 MIMIC: Added on "Chart" button when in "Configuration" mode. (Was commented out) 

(02/02/2004). 
 

 Issue #12578 MIMIC: Added scrollbars to hotlist. Added "Insert" mode to hotlist panel. (02/02/2004) 
 

 Issue #10548 MIMIC: Added GUI for storing formulas on server (02/02/2004) 
 

 Issue #11296 MIMIC: Improved performance of slow queries. Fixed by reducing the amount of message logging. 
 

 MIMIC: Added capability for user to change the "Rounding Mode" via "User Preferences" dialog. 

 MIMIC: Added "Look and Feel" to MIMIC's "Options" menu. (02/12/2004).  

 MIMIC: Improved performance when adding contracts. Significantly improved performance when accessing 

remote MIM Servers via VPN. (03/15/2004). 
 

 MIMIC: Improved browsing facilities. Faster browsing. Icons distinguish between normal relations and futures, 

columns and default columns. 
 

Bug Fixes: 

 Issue #10525 MIMIC: Units of measure conversions when server config is switched to XML/RPC or XML/HTTP. 
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 Issue #13375 MIMIC: During installation, default color properties were not be written correctly. (02/02/2004). 
 

 Issue #13352 MIMIC: When sorting tables with no Summary Stats, the last few item were not shown. 

(02/02/2004). 
 

 Issue#14005 MIMIC: Removing a row stops user from amending formulas. (02/19/2004).  

 Issue #14942 MIMIC: Formatting bug when value is NaN. 

 Issue #14943 MIMIC: Do not treat collapsing tree as a "selection" when previously selected node is descendant. 

 

Release 2.1.3 
 
 

Enhancements: 

 Issue #11296 MIMIC: Slow queries. Fixed by reducing the amount of message logging. (10/10/03). 
 

 Issue #11243 MIMIC: Added "Print Options" panel to "User Options". Allows user to set print orientation. 

(10/06/03) 
 

Bug Fixes: 

 Issue #11457 MIMIC: Fixed bug when adding contracts. (10/16/03) 
 

 Issue #10822 MIMIC: MIMIC bug in Seasonal Analysis - if show in chart/table not checked - still shows the 

heading in table (10/13/03) 
 

 Issue #10525 MIMIC: Fixed bug for units of measure conversions when server config is switched to XML/RPC 

or XML/HTTP (09/15/03) 

 

Release 2.1.2 
 
 

Enhancements: 

 Issue #10612 MIMIC: Buttons on MIMIC are replaced by “Please wait while the program fetches data from 

the server” 
 

Bug Fixes: 

 Issue #10457  MIMIC: Getting errors when trying to save worksheet using MIMIC 2.1.2 
 



  MIMIC 29 
 

  

 
 
 
 

Release 2.1.2 
 
 

Enhancements: 

 MIMIC: Added "Avg Weekly", "Quarterly" and "Avg Quarterly" to canned queries. (Enhancement) MIMIC: 

Filter for returning current month when monthly exec units selected. 

 

Bug Fixes: 

 Issue #10159 MIMIC: When using the "Add Contracts" button MIMIC got confused when it saw continuous 

relations with names like NG_19, thinking that "19" was a contract year. Now it identifies contracts using 

regular expression to match [A-Z][A-Z]_\d\d\d\d. 

 

Release 2.1.1 
 

Enhancements: 

 Issue #7625 MIMIC: Modified error message for "null" formulas to be more meaningful.  

 MIMIC: Symbol Browser changed how futures contracts and continuous relations are displayed. 
 

Bug Fixes: 

 Issue #7524 MIMIC: Fixed bug to set "Time Units" to default to "Daily" when previous llc item is null or does not 

have "Time Units". (i.e., formulas). 
 

 Issue #8584 MIMIC: Got NaNs for seasonal analysis queries. 
 

 MIMIC: Only allows selection of "Day", "Weeks" or "Months" for seasonal analysis queries. 
 
 
 
 
 

Release 2 2002/12/06 
 
 

Enhancements: 

 Issue #5647 MIMIC: Removed the 3x connection from MIMIC GUI and from the installer GUI. The connection can 

still be used just not setup by the user. 
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 Issue #5533 MIMIC: MIMIC will report when it cannot connect to a server and if the user is not entitled to view 

data. 
 

 Issue #4681MIMIC: Added the forward curve functionality. 
 

 Issue #4572 MIMIC: Added the ability to move and copy the table items. 

 

Bug Fixes: 

 Issue #5747 MIMIC: MIMIC was treating 0 as positive number, now it treats them as neither positive or 

negative. 
 

 Issue #6016 MIMIC: When seasonal is checked and the change period field is used the start date has a single 

day added to it plus the period change that that was selected. 

 

Release 2 2002/09/09 
 
 

Enhancements: 

 MIMIC: Added copy chart feature. 
 
 
 

Release 2 2002/08/28 and 2002/09/04 
 
 

Enhancements: 

 MIMIC: Added feature to force the seasonal calendar to seven day pattern.  

 MIMIC: MIMIC now runs and is shipped with the 1.4 JRE. 

 MIMIC: Added the ability to choose hotlist location during install.  

 MIMIC: Added the JavaScript engine. 

 MIMIC: Added the ability to choose chart save location during install.  

  Bug Fixes: 

  MIMIC: Fixed bug when trying to pull seasonal data and no is returned.  
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 MIMIC: Fixed bug with incorrect data at the end of seasonal table. 

 MIMIC: Fixed bug with trying to add contracts Jan-Jan.  

 MIMIC: Fixed bug with zero line when charting. 

 MIMIC: Fixed error message when password is incorrect. 
 

 MIMIC: Fixed bug with %change and deltas not being calculated when using the mouse pick. 

 

Release 2 2002/04/19 
 

Enhancements: 

 MIMIC: Sort contracts in add contracts in case the server returns them out of order. 

 MIMIC: Added daily when execution units daily to conversion factor. 

 MIMIC: Added multi-colored candlesticks to the charts.  

 MIMIC: Added ImpVol and Val to default column pecking order. 

 

Bug Fixes:  

 MIMIC: Fixed Summary stats "PctNeg", does no longer return a value when all date is positive.  

 MIMIC: Fixed the charts so that it displays dates in the users date format. 

 MIMIC: Monthly data extraction now forces day to 1st of month. Fixes problems with monthly seasonals. 
 

 
 
 
 

Release 2 2002/04/12 
 
 

Enhancements: 

 MIMIC: Added support for forcing 7 day trading pattern.  

 MIMIC: Added support for UK dates in mouse pick and x axis.  

 MIMIC: Added support for fill nearest. 
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 MIMIC: Now automatically paste in Excel without the new worksheet.  

Bug Fixes:  

 MIMIC: Fixed null pointer and other problems charting. 

 

 

Release 2 2001/11/01 
 
 

Bug Fixes:  

 MIMIC: Fixed problem with incorrect date scale of the chart.  

 MIMIC: Fixed problem with the Add Contracts Dialog hanging. 

 

 

Release 2001/09/10 
 
 

Bug Fixes:  

 (Enhancement) MIMIC: Added "MIMIC Password Check" box to the installer. 
 

 
 

Release 2 
 
 

Bug Fixes:  

 MIMIC: Fixed problem with the data box being too small to display the last line of data (In chart pick mode). 

 

Release 1 2001/08/23 
 
 

Bug Fixes:  

 MIMIC: Fixed problem with summary statistics containing data outside the data range specified. 
 
 
 
 
 

Release 1 2001/07/18 
 
 

Enhancements:  

 MIMIC: Start and End date now is used to filter MIM data to avoid extracting data fills from Saturday or Sunday 
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dates with Friday values. For, example, 7/1/2001 would return 6/29/2001 as a fill. Now the dates will be 

confined to the range in the MIMIC GUI. 
 

 MIMIC: Changed the add contracts dialog to return all contracts between the start and end year and the start 

and end month. The prior behavior was to return all of the contracts from the start year and start month or 

the end year and end month. This should make extracting all contracts of a month or season strips much 

easier. 
 
 
 

Release 1 2001/03/06 
 

 Enhancements:  

 MIMIC: Created new install package. It is a single file self-extracting executable. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


